Wany man will drate up bis
case, aid put his pame ar the
Joot of the first page, [ will
give hitn an inimediate
reply. Where he co pels e
ta turn over the sheet,

must it ney leisure.

rd Sandwich

Ritle One: Our client is %«
always right.

Rule Tiwo: If you think our
client is wrong, see Rule

One.

—Anoenymous

A fair question should be
Jollawed by a deed in silence.

~—Dante Alighieri

You will come heve aud yer
d
books that will open your
eyes. and your ears, and youyr
curigsity, and turn you
inside out or autside in.

" «Ralph Waldo Emerson
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25.1 Introduction

This chaprer introduces web application development with Microsoft’s Active Server
Pages .NET (ASP.NET) 2.0 technology. Web-based applications create web content for
web-browser clients. This web content includes Extensible HyperText Markup Language
(XHTML), client-side scripting, images and binary darta. If you are not familiar with
XHTML, you should read Chapter 4 before studying this chapter. [ Note: This chapter ass-
umes that you know Visual Basic and are familiar with the .NET platform version 2.0.
To learn more about Visual Basic, check out Visual Basic 2005 How to Program, Third Edi-
tion, or visit our Visual Basic Resource Center at www.deitel. com/visualbasic.]

We present several examples that demonstrate web application development using
Web Forms, web controls {also called ASP.NET server controls} and Visual Basic pro-
gramming. We also introduce ASP.NET Ajax and use it to enhance one of the eatlier
examples. Web Form files have the filename extension .aspx and contain the web page’s
GUI. You customize Web Forms by adding web controls including labels, text boxes,
images, burtons and other GUI components. The Web Form file generates the web page
that is sent to the client browser. From this point onward, we refer to Web Form files as

ASPX files.
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An ASPX file created in Visua! Studio is implemented as a class written in a NET
language, such as Visual Basic. This class contains event handlers, initialization code,
utility methods and other supporting code. The file that contains this class is called the
code-behind file and provides the ASPX file’s programmatic implementation. -

To develop the code and GUIs in this chapter, we used Microsoft Visual Web Devel-
oper 2005 Express—an IDE designed for developing ASP.NET web applications. Visual
Web Developer and Visual Basic 2005 Express share many common features and visual.
programming tools that simplify building complex applications, such as those that access
a datahase (Sections 25.5-25.6). The full version of Visual Studio 2005 includes the func-
tionality of Visual Web Developer, so the instructions we present for Visual Web Devel-
oper also apply to Visual Studio 2005. Note that you must install eicher Visual Web
Developer 2005 Express (available from msdn.microsoft.com/vstudio/express/vwd/
default.aspx) or 2 complete version of Visual Studio 2005 to implement the programs
in this chapter.

25.2 Creating and Running a Simple Web Form Example

Our first example displays the web server’s time of day in a browser window. When run,
this program displays the text A Simple Web Form Example, followed by the web server's
time. As mentioned previously, the program consists of two related files—an ASPX file
(Fig. 25.1) and a Visual Basic code-behind file (Fig. 25.2), which we’ll discuss in
Section 25.2.5. We first display the markup, code and output, then we carefully guide you
through the step-by-step process of creating this program. [ Note: The markup in Fig. 25.1
and other ASPX file llsnngs in this chapter is the same as the markup that appears in Visual
Web Developer, but we’ve reformatted it for presentation putposes to make the code more
readable.]

Visual Web Developer generates all the markup shown in Fig. 25.1 when you set the
web page’s title, type text in the Web Form, drag a Labe onto the Web Form and set the
properties of the page’s text and the Label. We discuss these steps in Section 25.2.6.

Fig. 25.1 | ASPX file that displays the web server's time. (Part | of 2.)
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Fig. 25.1 | ASPX file that displays the web server's time. (Part 2 of 2.)

25.2.1 Examining an ASPX File

The ASPX file contains other information in addition to XHTML. Lines 1-2 are
ASP.NET comments that indicate the figure number, the filename and the purpose of the
file. ASP.NET comments begin with <%~ and terminate with'--%. We added these com-
ments to the file, ASP.NET comments are not output as part of the XHTML sent to the
client. Lines 3—4 use a Page directive (in an ASPX file 2 directive is delimited by <%@ and
%) to specify information needed by ASP.NET to process this file. The Language atcri-
bute of the Page directive specifies the language of the code-behind file as Visual Basic
("v8"); the code-behind file {i.c., the CodeFile) is WebTime.aspx.vb. A code-behind file-
name usually consists of the full ASPX filename (e.g., WebTime. aspx) followed by a file-
name extension indicating the programming language (.vb in this chapter’s examples).

The AutoEventWireup atiribute (line 3} determines how Web Form events are han-
dled. When AutoEventWireup is set to true, ASP.NET determines which methods in the
class are called in response to events generated in the Page. For example, ASP.NET will
call methods Page_Init and Page_Load in the code-behind file to handle the Page’s Init
and Load events, respectively. AutoEventWireup requires the event-handling methods to
follow specific naming copnventions. (We discuss these events later in the chapter.)

The Inherits attribute (line 4) specifies the page’s class name—in this case, WebTime,
We say more about Inherits momentarily. [Note: We explicitly set the EnableSession-
State attribute (line 4) to False. We explain the significance of this attribute later in the
chapter. The IDE sometimes generates attribute values (e.g., true and false) and control
names (as you will see later in the chapter) that do not adhere to our standard code capi-
talization conventions (i.e., True and False). Like Visual Basic, ASP.NET markup is not
case sensitive, so using a different case is not problematic. To remain consistent with the
code generated by the IDE, we do not modify these values in our code listings or in our
accompanying discussions.]

For this first ASPX file, we provide a brief discussion of the XHTML markup. For
more information on XHTML, sce Chapter 4. Lines 6-7 contain the document rype dec-
laration, which specifies the document element name (HYML) and the PUBLIC Uniform
Resource Identifier (URI) for the DTD that defines the XHTML vocabulary.

Lines 9-10 contain the <html> and <head> start tags, respectively. XHTML docu-
ments have the root element htm1 and mark up information about the document in the
head element. Also note that the html element specifies the XML namespace of the doc-
ument using the xmIns ateribute (see Section 14.4),
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Notice the runat attribute in line 10, which is set to "server”. This atcribute indi-
cates that when a client requests this ASPX file, ASP.NET processes the head element and
its nested elements on the server and generates the corresponding XHTML, which is then
sent to the client. In this case, the XHTML sent to the client will be identical to the
markup in the ASPX file. However, as you will see, ASP.NET can generate complex
XHTML markup from simple elements in an ASPX file.

Line 11 sets the title of this web page. We demonstrate how to set the title through a
property in the IDE shortly. Line 13 contains the <body> start tag, which begins the body
of the XHTML document; the body contains the main content that the browser displays.
The form that contains our XHTML text and controls is defined in lines 14-24. Again,
the runat attribute in the form element indicates that this element executes on the server,
which generates equivalent XHTML and sends it to the client. Lines 15-23 contain a div
element thar groups the elements of the form in a block of markup.

Software Engineering Observation 25.1

Most ASP.NET controls must be placed in a form element in which the <form tag has the
runat="server" gttribute.

Lines 16-17 are an XHTML h2 heading element. As we demonstrate shortly, the
IDE generates this element in response to typing text directly in the Web Form and
selecting the text as a second-level heading;

Lines 1822 contain a p-element to mark up a paragraph of content in the browser.
Lines 19-21 mark up a Label web control. The properties that we set in the Properties
window, such as Font-Size and BackColor (i.e., background color), are attributes here.
The ID attribute (line 19) assigns a name to the control so that it can be manipulared pro-
grammartically in the code-behind file. We set the control’s EnabteViewState attribute
(line 20) to False. We explain the significance of this ateribute later in the chapter.

The asp: tag prefix in the declaration of the Label tag (line 19) indicates that the
label is an ASP.NET web control, not an XHTML element. Each web control maps to'a
corresponding XHTML element (or group of clements)—when processing a web control
on the server, ASP.NET generates XHTML markup that will be sent to the client to rcp-

resent that control in a web browser,

Portability Tip 25.1 .
m The same web control can map to different XHTML elements, dq:mdmg on the client browser
and the web control’s property settings. .~ . .

In this example, the asp:Label control maps to the XHTML span element (i.e.,
ASP.NET creates a span element to represenc this control in the client’s web browser). A
span element particular element is used because span elements allow formatting styles to
be applied to text. Several of the property values that were applied to our label are repre-
sented as part of the style attribute of the span element. You will soon see what the gen-
erated span element’s markup looks like.

The web control in this example contains the runat="server" attribute—value pair
(line 19), because this control must be processed on the server so that the server can trans-
late the control into XHTML thar can be rendered in the client browser. If this attribute
pair is not present, the asp:Labe1 element is written as text to the client (i.e., the control
is not converted into a span element and does not render properly). AR
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25.2.2 Examining a Code-Behind File

Figure 25.2 presents the code-behind file. Recall that the ASPX file in Fig. 25.1 references
WebTime.aspx.vb in line 3. .

Line 3 (Fig. 25.2) begins the declaration of class WebTime. A class declaration can span
multiple source-code files, and the separate portions of the class declaration in each file are
known as partial classes. The Partial modifier in line 3 indicates that the code-behind file
is a partial class. We discuss the remainder of this class shortly.

Line 4 indicates thar WebTime inherits from class Page in namespace System.Web.UI.
This namespace contains classes and controls that assist in building web-based applica-
tions. Class Page provides events and objects necessary for creating web-based applica-
tions. In addition to class Page, System.Web.UI also includes class Control—the base class
that provides common functionality for all web controls.

Lines 7—11 define method Page_Init, which handles the page’s Init event. This
event indicates that all the controls on the page have been created and initialized and addi-
tional application-specific initialization can now be performed. The oply initialization
required for this page is setting timeLabel’s Text property to the time on the server (ie.,
the computer on which chis code executes). The starement in line 10 retrieves the current
time and formats it as bh: mm:ss. For example, 9 AM is formartted as 09:00:00, and 2:30
PM is formatted as 14:30:00. Notice that the code-behind file can access timeLabel (the
ID of the Labe1 in the ASPX file) programmatically, even though the file does nor contain
a declaration for a variable named timetabel. You will learn why momentarily.

PV A
' display the server's curg
DateTime.Now.To

Fig. 25.2 | Code-behind file for a page that displays the web server's time.
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25.2.3 Relationship Between an ASPX File and a Code-Behind File

How are the ASPX and code-behind files used to create the web page that is sent to the
client? Firse, recall that class webTime is the base class specified in line 4 of the ASPX file
(Fig. 25.1). This class (partially declared in the code-behind file) inherits from Page,
which defines general web page functionality. Partial class webTime inherits this function-
ality and defines some of its own (i.c., displaying the current time). The code in the code-
behind file displays the time, whereas the code in the ASPX file defines the GUL

When a client requests an ASPX file, ASP.NET creates two partial classes behind the
scenes. The code-behind file contains one partial class named webTime and ASP.NET gen-
erate another partiat class containing the remainder of class webTime, based on the markup
in the ASPX file. For example, WebTime. aspx contains a Label web control with ID time-
Label, so the generared parrial class would contain a declaration for a variable named
timeLabel of rype System.Web.UI.WebControls.label. Class Label represents a web
control for displaying text. It is defined in namespace System.Web.UI.WebControls,
which contains web controls for designing a page’s user interface. Web controls in this
namespace derive from class WebControl. When compiled, the partial class that declares
timeLabel combines with the code-behind file’s partial class declaration to form the com-
plete WebTime class. This explains why line 10 in Fig. 25.2 can access timetabel, which is
created in lines 19-21 of webTime.aspx (Fig. 25.1)—method Page_Init and control
timeLabel are actually members of the same class, but defined in separate partial classes.

The partial class generated by ASP.NET is based on the ASPX file that defines the
page’s visual representartion. This partial class is combined with the one in Fig. 25.2, which
defines the page’s logic. The first time the web page is requested, this class is compiled and
an instance is created. This instance represents the page and creares the XHTML that is
sent to the client. The assembly created from the compiled partial classes is placed in a sub-
directory of :

C:\WINDOWS\Microsoft.NET\Framework\ VersionNumber\
Temporary ASP.NET Files\WebTime

where VersionNumber is the version number of the NET Framework (e.g., v2.0.50727)
installed on your computer. ,

Once the web page has been compiled, no recompilation is required on subsequent
requeses. New instances of the web page class will be created to serve each request. The
project will be recompiled only when you modify the application; changes are detected by
the runtime environment, and the application is recompiled to reflect the altered content.

25.2.4 How the Code in an ASP.NET Web Page Executes

Let’s look briefly at how the code for our web page executes. When an instance of the page
is created, the PreInit event occurs first, invoking method Page_PreInit, which can be
used to set a page’s theme and look-and-feel (and perform other tasks thar are beyond this
chapter’s scope). The Init event occurs next, invoking method Page_Init. Method
Page_Init is used to initialize objects and other aspects of the page. After Page_Init exe-
cutes, the Load event occurs, and the Page_Load event handler executes. Although not
present in this example, the PreInit and Load events are inherited from class Page. You
will see examples of the Page_Load event handler later in the chapter. After the Load event
handler finishes executing, the page processes events that are generared by the page’s
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controls, such as user interactions with the GUL When the user’s request is considered
fully processed, an Unlead event occurs, which calls the Page_Unload event handler. This
event, too, is inherited from class Page. Page_Un1load typically contains code that releases
resources used by the page. Other events occur as well, but are typically used only by
ASP.NET controls to generate XHTML to render client-side controls. You can learn more
about a Page’s event life cycle at msdn2 .microsoft.com/en-US/1ibrary/ms178472 . aspx.

25.2.5 Examining the XHTML Generated by an ASP.NET Application

Figure 25.3 shows the XHTML generated by ASP.NET when a client browser requests
WebTime.aspx (Fig. 25.1). To view this code, select View > Source in Internet Explorer.
We added the comments in lines 1-2 and reformatted the XHTML for readability.

The markup in this page is similar to the ASPX file. Lines 7-9 define a document
header comparable to that in Fig. 25.1. Lines 10-25 define the document’s body. Line 11
begins the form, a mechanism for collecting user information and sending it to the web
server. In this particular program, the user does not submit data to the web server for pro-
cessing; however, processing user data is a crucial part of many applications that is facili-
tated by forms. We demonstrate how to submit form data to the server in later examples:

- XHTML forms can contain visual and nonvisual components. Visual components
include burtons and other GUI components with which users interact. Nonvisual compo-
nents, called hidden inputs, store data, such as e-mail addresses, that the document author
specifies. A hidden input is defined in lines 13—14. We discuss the precise meaning of this

Fig. 25.3 | XHTML response when the browser requests WebTime . aspx.
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hidden input later in the chapter. Attribute method of the form element (line 11) specifies
the method by which the web browser submits the form to the server. The action
attribute identifies the name and location of the resource that will be requested when this
form is submitted-—in this case, webTime.aspx. Recall that the ASPX file’s form element
contained the runat="server" attribute—value pair {line 14 of Fig. 25.1). When the form
is processed on the server, the runat attribute is removed. The method and action
ateributes are added, and the resulting XHTML form is sent to the client browser.

In the ASPX file, the form’s Label (i.e., timeLabel) is a web control. Here, we are
viewing the XHTML created by our application, so the form contains a span element
(lines 20-21 of Fig. 25.3) to represent the text in the label. In this particular case,
ASP.NET maps the Label web control to an XHTML span element. The formatting
options that were specified as properties of timeLabe?, such as the font size and color of
the text in the Label, are now specified in the style attribute of the span element.

Notice that only those elements in the ASPX file marked with the runat="server"
artribure—value pair or specified as web controls are modified or replaced when the file is
processed by the server. The pure XHTML elements, such as the h2 in line 18, are sent to
the browser as they appear in the ASPX file.

25.2.6 Building an ASP.NET Web Application

Now that we have presented the ASPX file, the code-behind file and the resulting web page
sent to the web browser, we show the steps we used to create this application in Visual Web
Developer.

Step 1: Creating the Website

In Visual Web Developer, select File > New Web Stte... to display the New Web Site dialog
(Fig. 25.4). In this dialog, select ASP.NET Web Site in the Templates pane. Below this
pane, there are two fields in which you can specify the type and location of the web

S ASP.NET Web Service @RParsonal Web Ska Startar Kit

Fig. 25.4 | Creating an ASP.NET Web Slte in Visual Web Developer.
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application you are creating. If it is not already selected, select HTTP from the drop-down
list closest to Location. This indicates that the web application should be configured to run
as an IS application using HTTP (either on your computer or on a remote computer).
We want our project to be located in http://1ocalhost, which is the URL for 118’s roor
dir- ecrory (this URL normally corresponds to the C:\InetPub\wwwroot directory on your
machine). The name Tocalhost indicates that the server resides on local computer. If the
web server were located on a different computer, Tocalhost would be replaced with the
appropriate IP address or hostname. By default, Visual Web Developer sets the location
where the website will be created to http://localhost/WebSite, which we change to
http://localhost/WebTime. o

If you do not have IIS on your computer or do not have permission to access it, you
can select File System from the drop-down list next to Location to create the web applica-
tion in a folder on your computer. You will be able to test the application using Visual
Web Developer's internal ASP.NET Development Server, but you will not be able to
access the application remotely over the Internet.

The Language drop-down list in the New Web Site dialog allows you to specify the
language (i.e., Visual Basic, Visual C# or Visual }#) in which you will write the code-
behind file(s) for the web application. Change the setting to Visual Basic. Click OK ro
create the website. This creates the directory C:\Inetpub\wwwroot\WebTime (in IIS) and
makes it accessible through the URL http://1ocalhost/WebTime. This action also creates
a WebTime directory in the directory My Documents\Visual Studio 2005\Projects in
which the project’s solution files {e.g., WebTime . s1n) are stored.

Step 2: Examining the Solution Explorer of the Newly Created Project

The next several figures describe the new project’s content, beginning with the Solution
Explorer shown in Fig, 25.5. Like Visual Basic 2005 Express, Visual Web Developer cre-
ates several files when you create a new project. It creates an ASPX file (i.e., Web Form)
named Default.aspx for each new ASP.NET Web Site project. This file is open by default
in the Web Forms Designer in Source mode when the project first loads (we discuss this
momentarily). As mentioned previously, a code-behind file is included as part of the
project. Visual Web Developer creates a code-behind file named Default.aspx.vb. To
open the ASPX file’s code-behind file, right click the ASPX file and select View Code or
click the View Code burton (£]) at the top of the Solution Explorer. Alternatively, you can

Fig. 25.5 | Solution Explorer window for project WebTime.
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expand the node for the ASPX file to reveal the node for the code-behind file (see
Fig. 25.5). You can also choose to list all the files in the project individually (instead of
nested) by clicking the Nest Related Fiies button—this option is turned on by default, so
clicking the button toggles the option off.

The Properties and Refresh buttons in Visual Web Developer’s Solution Explorer
behave like those in Visual Basic 2005 Express. Visual Web Developer's Solution Explorer
also contains the burtons View Designer, Copy Web Site and ASP.NET Configuration. The
View Designer button aliows you to open the Web Form in Design mode, which we discuss
shortly. The Copy Web Site button opens a dialog that allows you to move the files in this
project to another location, such as a remote web server. This is useful if you are devel-
oping the application on your local computer, but want to make it available to the public
from a different location. Finally, the ASP.NET Configuration button takes you o a web
page called the Web Site Administration Tool, where you can manipulate various settings
‘and security options for your application. We dlscuss this tool in greater detail in

Section 25.6.

Step 3: Examining the Toolbox in Visual Web Developer

Figure 25.6 shows the Toolbox displayed in the IDE when the project loads. Figure 25.6(a)
displays the beginning of the Standard list of web controls, and Fig. 25.6(b) displays the
remaining web controls, and the list of Data controls used in ASP.NET'. We discuss specific
controls in Fig. 25.6 as they are used throughout the chapter. Notice that some controls in
the Toolbox are similar to Windows controls.

Fig. 25.6 | Toolbox in Visual Web Developer.
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Step 4: Examining the Web Forms Designer

Figure 25.7 shows the Web Forms Designer in Source mode, which appears in the center
of the IDE. When the project loads for the first time, the Web Forms Designer displays
the autogenerated ASPX file (i.e., Default.aspx) in Source mode, which allows you to
view and edit the markup that comprises the web page. The markup listed in Fig. 25.7 was
created by the IDE and serves as a template that we will modify shortly. Clicking the Des-
Ign button in the lower-left corner of the Web Forms Designer switches to Design mode
(Fig, 25.8), which allows you to drag and drop controls from the Toolbox onto the Web
Form and see the controls. You can also type at the current cursor location to add text to
the web page. We demonstrate this shortly. In response to such actions, the IDE generates
the appropriate markup in the ASPX file. Notice that Design mode indicates the XHTML
element where the cursor is currently located. Clicking the Source button returns the Web
Forms Designer to Source mode, where you can see the generated markup.

<!DOCTYPE heml PUBLIC "~//WSC//DID XMTML 1.0 Transitional//EN*

"hLgli/ /i WAL K/ IR SRt A IR/ khEml 1- CEARSA SIRDAL . Q0>

<btmi xmins="hiro://wN N 0ra/19%9/RERl" >
<haad runat="perver">
<ticledUncitlied Baga</titler
</head>
<body>
<form id**forml® runst="perver®>
<divy

</div»
</ Lorm>
</hody>

Fig. 25.8 | Design mode of the Web Forms Designer.
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Step 5: Examining the Code-Behind File in the IDE

The next figure (Fig. 25.9) displays Default. aspx.vb—the code-behind file generated by
Visual Web Developer for Default.aspx. Right click the ASPX file in the Solution Expl-
orer and select View Code to open the code-behind file. When it is first created, this file
contains nothing more than a partial class declaration. We will add the Page_Init event
handler to this code momentarily.

i

2'F Partial Class Pafault

’i Inherits System, ¥eb.UI.Page
4

¥ ~End {lass

Fig. 25.9 | Code-behind file for Default.aspx generated by Visual Web Developer.

Step 6: Renaming the ASPX File

Now that you've seen the contents of the default ASPX and code-behind files, let’s rename
these files. Right click the ASPX file in the Solution Explorsr and select Rename. Enter the
new filename WebTime.aspx and press Enzer. This updates the name of both the ASPX file
and the code-behind file. The IDE also updates the Page directive’s CodeFile attribute in
WebTime. aspx.

Step 7: Renaming the Class in the Code-Behind File and Updating the ASPX File
Although renaming the ASPX file causes the name of the code-behind file to change, this
action docs not affect the name of the parrial class declared in the ‘code-behind file. Open
the code-behind file and change the class name from _Default (line 2 in Fig. 25.9) to
WebTime, so the partial class declaration appears as in line 3 of Fig, 25.2. Recall that this
class is also referenced by the Page directive in the ASPX file. Using the Web Forms Des-
igner’s Source mode, modify the Inherits auribute of the Page directive in WebTime.
aspx, so it appears as in line 4 of Fig. 25.1. The value of the Inherits attribute and the
class name in the code-behind file must be identical; otherwise, you'll get errors when you
build the web application.

Step 8: Changing the Title of the Page

Before designing the content of the Web Form, we change its title from the default unti-
tled Page (line 9 of Fig. 25.7) to A Simple Web Form Example. To do so, open the ASPX
file in Source mode and modify the texr in the title element—i.e., the text between the
tags <titTe> and </title>. Alternatively, you can open the ASPX file in Design mode and
modify the Web Form’s Title property in the Properties window. To view the Web
Form’s properties, select DOCUMENT from the drop-down list in the Properties window;
DOCUMENT represents the Web Form in the Properties window:

Step 9: Designing the Page
Designing 2 Web Form is as simple as designing a Windows Form. To add controls to the
page, drag-and-drop them from the Toolbox onto the Web Form in Design mode. Like the
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Web Form itself, each control is an object that has properties, methods and events. You
can set these properties and events visually using the Properties window or programmati-
cally in the code-behind file. However, unlike working with a Windows Form, you can
type text directly on a Web Form at the cursor location or insert XHTML elements from
the Toolbox.

Controls and other elements are placed sequentially on a Web Form, much as textand
images are placed in a document using word-processing software like Microsoft Word.
Controls are placed one after another in the order in which you drag-and-drop them onto
the Web Form. The cursor indicates the point at which text and XHTML elements will
be inserted. If you want to position a control between existing text or controls, you can
drop the control at a specific position within the existing elements. You can also rearrange
existing controls using drag-and-drop actions. By default, controls flow based on the width
of the page. An alternate type of layout is known as absolute positioning, in which con-
trols are located exactly where they are dropped on the Web Form. You can enable abso-
lute positioning in Design mode by selecting Layout > Position > Auto-position Options....,
clicking the first checkbox in the Positioning options pane of the Options dialog that
appears, then selecting the appropriate positioning option from the drop-down menu.

. Portability Tip 25.2

Absolute positioning is discouraged, because pages designed in this manner may not render cor-
W rectly on computers with different screen resolusions and font sizes. This could cause absolutely
positioned elements to overlap each other or display off-screen, requiring the client to scroll to see
the full page content.

In this example, we use one piece of text and one Label. To add the text to the Web
Form, click the blank Web Form in Design mode and type Current time on the Web
server:. Visual Web Developer is a WYSIWYG (What You See Is What You Get)
editor—whenever you make 2 change to a Web Form in Design mode, the IDE creates the
markup (visible in Source mode) necessary to achieve the desired visual effects seen in
Design mode. After adding the text to the Web Form, switch to Source mode. You should
see that the IDE added this text to the div element that appears in the ASPX file by
default. Back in Design mode, highlight the text you added. From the Block Format drop-
down list (see Fig. 25.10), choose Heading 2 to format this text as a heading that will
appear bold in a fonc slightly larger than the default. This action encloses the text in an
h2 element. Finally, click to the right of the text and press the Enter key to start a new para-
graph. This action generates a p (paragraph) element in'the ASPX file’s markup The IDE
should now lock like Fig. 25.10.

You can place a Label on a Web Form either by draggmg—and dropping or by double
clicking the Toolbox’s Label control. Ensure that the cursor is in the new paragraph then
add a Label thar will be used to display the time. Using the Properties window, set the
(ID) property of the Labe1 to timeLabel. In the Text property, delete timeLabel’s text—
this text will be set programmatically in the code-behind file. When a Labe1 does not con-
tain text, its name is displayed in square brackets in the Web Forms Designer (Fig. 25.11)
as a placeholder for design and layout purposes. This text is not displayed at execution
time. We set timeLabel’s BackColor, ForeColor and Font-Size properties to Black,
Yellow and XX-Large, respectively. To change the Label’s font properties, select the
Labe1, expand the Font node in the Properties window and change each relevant property.
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Fig. 25.10 | webTime.aspx after inserting text and a new paragraph.

As the Label’s properties are set, Visual Web Developer updates the ASPX file’s contents.
Figure 25.11 shows the IDE after setting these properties.

Next, set the Label’s EnableViewState property to False. Finally, select DOCUMENT
from the drop-down list in the Properties window and set the Web Form’s EnableSe-
ssionState property to False. We discuss both of these properties later in the chapter.

!M Sy e L WebContTols
e

Fig. 25.11 | wWebTime.aspx after adding a Labe1 and setting its properties.
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Step 10: Adding Page Logic

Now that you've designed the user interface, you'll add Visual Basic code to the code-beh-
ind file to obtain the server’s time. Open WebTime.aspx.vb by double clicking its node
in the Solution Explorer. In this example, we add a Page_Init event handler (lines 7-11 of
Fig. 25.2) to the code-behind file. Recall thar Page_Init handles the Init event and con-
rains code to initialize the page. The statement in line 10 of Fig. 25.2 sets timeLabe1’s text
to the server’s current time.

Step 11: Running the Program

After creating the Web Form, you can view it several ways. First, you can select Debug >
Start Without Debugging, which runs the application by opening it in a browser window.
If you created the application on your local IIS server (as we did in this example), the URL
shown in the browser will be http://1ocalhost/WebTime/WebTime.aspx (Fig. 25.2),
indicating that the web page (the ASPX file) is located within the virtual directory WebTime
on the local 1IS web server. 1S must be running to test the website in a browser. IIS can
be started by exccuting inetmgr.exe from Start > Run..., right clicking Defautt Web She
and selecting Start. {Noze: You might need to expand the node representing your computer
to display the Default Web Ste.]

If you created the ASP.NET application on the local file system, the URL shown in
the browser will be http: //1ocalhost: PortNumber/WebTime /WebTime. aspx, where Port-
Number is the number of the randomly assigned port on which Visual Web Developer’s
built-in test server runs. The IDE assigns the port number on a per-solution basis. This
URL indicates that the WebTime project folder is being accessed through the root directory
of the test server running at localhost: PortNumber. When you select Debug > Start
Without Debugging, a tray icon appears near the bottom-right of your screen next to the
computer’s date and time to show that the ASP.NET Development Server is running. The
test server stops when you exit Visual Web Developer.

To debug your application, you can select Dabug > Start Debugging to view the web
page in a web browser with debugging enabled. You cannot debug a web application
unless debugging is explicitly enabled by the Web.conf1g file—a file that stores configura-
tion settings for an ASP.NET web application. You will rarely need to manually creare or
modify Web.config. The first time you select Debug > Start Debugging in 2 project, a
dialog appears and asks whether you want the IDE to modify the Web. config file to enable
debugging. After you dick OK, the IDE enters Ruaning mode. You can exit Running mode
by selecting Debug > Stop Debugging in Visual Web Developer or by closing the browser
window in which the ASPX file is displayed.

To view a specific ASPX file, you can right click either the Web Forms Designer or
the ASPX filename (in the Solution Explorer) and select View In Browser to load the page
in a web browser. Right clicking the ASPX file in the Solution Explorer and selecting
Browse With... also opens the page in a browser, but first allows you to specify the web
browser that should display the page and its screen resolution.

Finally, you can run your application by opening a browser window and typing the
web page’s URL in the Address field. When testing an ASP.NET application on the same
computer running IS, type http://local host/ProjectFolder/ PageName.aspx, where
PrajectFolder is the folder in which the page resides (usually the name of the project), and
PageName is the name of the ASP NET page. If your application resides on the local file
system, you must first start the ASP.NET Development Server by running the application
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using one of the methods described above. Then you can type the URL (including the

PortNumber found in the test server’s tray icon) in the browser to execute the application.

Note that all of these methods of running the application compile the project for you.

In fact, ASP.NET compiles your web page whenever it changes between HT TP requests.

For example, suppose you browse the page, then modify the ASPX file or add code to the

code-behind file. When you reload the page, ASP.NET recompiles the page on the server

before returning the HTTP response to the browser. This important new behavior of

" ASP.NET 2.0 ensures that clients always see the latest version of the page. You can man-

ually compile a web page or an entite website by sclecting Bulld Page or Build Site, respec-
tively, from the Bulld menu in Visual Web Developer.

Windows Firewall Settings

If you would like to test your web application over a network, you may need to change
your Windows Firewall settings. For security reasons, Windows Firewall does nort allow
remote access to a web server on your local computer by default. To change this, open the
Windows Firewall utility in the Windows Control Panel. In Windows XP, Click the Adv-
anced tab and select your network connection from the Network Connection Settings list,
then click Settings.... On the Services tab of the Advanced Settings dialog, ensure thac
Waeb Server {HTTP) is checked. In Windows Vista click the Change settings link, then click
Continue in dialog that appears. Select the Exceptions tab and place a check next to World
Wide Web Services (HTTP).

25.3 Web Controls

This section introduces some of the web controls located in the Standard section of the
Toolbox (Fig. 25.6). Figure 25.12 summarizes some of the web controls used in the chap-
ter examples.

Fig. 25.12 | Commonly used web controls.

25.3.1 Text and Graphics Controls

Figure 25.13 depicts a simple form for gathering user input. This example uses all the con-
trols listed in Fig. 25.12, except Label, which you used in Section 25.2. The code in
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Fig. 25.13 was generated by Visual Web Developer in response to dragging controls onto
the page in Design mode. To begin, create an ASP.NET website named webControls.
[Note: This example does not conrtain any functionality—i.e., no action occurs when the
user clicks Register. We ask you to provide the functionality as an exercise. In subsequent
examples, we demonstrate how to add functionality to many of these web controls.]

e-ID="userInformationlnige’
elirls

sp: TextBox 10u"Fi i‘stﬂam extBox" . runat "server”
£nableViewStates"False ></asp: TaxtBoxs"

SE e i
Fig. 25.13 | Web Form that demonstrates web controls, {Part | of 3.)
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RadioButtoniist ID="operatingSystemRadicButtonL
runat="server® EnableViewState="False"s v 7.1
<asp:ListItem=Windows XP</asp:iListItem>
<asp:listItesWindows: 2000</asp:Listitems
T<aspilistItem>Windows NT</asp:ListItem>
<asp:ListItem>tinux</asp:ListItem>
<aspilListItensOther</asp:Listivems
dioButtonList

Fig. 25.13 | Web Form that demonstrates web controls. (Part 2 of 3.)
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Which operating system ane vou wsing?

Fig. 25.13 | Web Form that demonstrates web controls. (Part 3 of 3.)

Before discussing the web controls used in this ASPX file, we explain the XHTML
that creates the layout seen in Fig. 25.13. The page contains an h3 heading element (kne
16), followed by a series of additional XHTML blocks. We place most of the web controls
inside p elements (i.e., paragraphs), but we use an XHTML tab1e element (lines 25-55}
to organize the Image and TextBox controls in the user information section of the page. In
the preceding section, we described how to add heading elements and paragraphs visually
without manipulating any XHTML in the ASPX file directly. Visual Web Developer
allows you to add a table in a similar manner.
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Adding an XHTML Table to a Web Form

To create a table with two rows and two columns in Design mode, select the Insert Table
command from the Layout menu. In the Insert Table dialog that appears, select the Custom
radio button. In the Layout group box, change the values of Rows and Columns to 2. By
default, the contents of a table cell are aligned vertically in the middie of the cell. We
changed the vertical alignment of all cells in the table by clicking the Cell Properties... but-
ton, then selecting top from the Vertical align combo box in the resulting dialog. This cau-
ses the content of each table cell to align with the top of the cell. Click OK to close the Cell
Properties dialog, then click OK to close the Insert Table dialog and create the table. Once
a table is created, controls and text can be added to particular cells to create 2 neatly orga-
nized layout.

Setting the Color of Text on a Web Form

Notice that some of the instructions to the user on the form appear in a teal color. To set
the color of a specific piece of text, highlight the text and select Format > Foreground
color.... In the Cotor Picker dialog, click the Named Colors tab and choose a color. Click OK
to 2pply the color. Note that the IDE places the colored text in an XHTML span element
(e.g., lines 22-23) and applies the color using the span’s style attribute.

Examining Web Controls on a Sample Registration Form

Lines 2021 of Fig, 25.13 define an Image control, which inserts an image into a web page.
The images used in this example are located in the chapter’s examples directory. You can
download the examples from www.deitel.com/books/iw3htp4. Before an image can be
displayed on a web page using an Image web control, the image must first be added to the
project. We added an Images folder to this project (and to each example project in the
chapter that uses images) by right clicking the location of the project in the Solution Explo-
rer, selecting New Folder and entering the folder name Images. We then added each of the
images used in the example to this folder by right clicking the folder, selecting Add Existing
tem... and browsing for the files to add. You can also drag a folder full of images onto the
project’s location in the Solution Explorer to add the folder and all the images to the project.

The ImageUrl property (line 21} specifies the location of the image to display in
the Image control. To select an image, click the ellipsis next to the ImageUr1 property
in the Properties window and use the Select Image dialog to browse for the desired image
in the project’s Images folder. When the IDE fills in the ImageUr1 property based on
your selection, it includes a tilde and forward slash (~/) at the beginning of the Ima-
geUr1-—this indicates that the Images folder is in the root directory of the project.

Lines 25-55 contain the table element created by the steps discussed previously.
Fach td element contains an Image control and a TextBox control, which allows you to
obtain text from the user and display text to the user. For example, lines 30-31 define a
TextBox control used to collect the user’s first name.

Lines 64—73 define a DropDownList. This control is similar to the XHTML select
control. When a user clicks the drop-down list, it expands and displays a list from which
the user can make a selection. Each item in the drop-down list is defined by a ListItem
element (lines 66-72). After dragging a DropDownList control onro a Web Form, you can
add items to it using the Listitem Collection Editor. This process is similar to customizing
a ListBox in a Windows application. In Visual Web Developer, you can access the Listitern
Collection Editor by clicking the ellipsis next to the Items property of the DropDownList,
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or by using the DropDownLlist Tasks menu. You can open this menu by clicking the small
arrowhead that appears in the upper-tight corner of the control in Design mode
(Fig. 25.14). This menu is called a smart tag menu. Visual Web Developer displays smart
tag menus for many ASP.NET controls to facilitate common tasks. Clicking Edit Items...
in the DropDownlList Tasks menu opens the Listitem Coliection Editor, which allows you to
add ListItem elements to the DropDownList.

The HyperLink control (lines 76-80 of Fig. 25.13) adds a hyperlink to a web page.
The NavigateUrl property (line 77) of this control specifies the resource (i.e., http://
www.deitel.com) that is requested when a user clicks the hyperlink. Setting the Target
property to _blank specifies thar the requested web page should open in 2 new browser
window. By default, HyperLink controls cause pages to open in the same browser window.

Lines 89-96 define a RadioButtonList control, which provides a series of radio burt-
tons from which the user can select only one. Like options in a DropDownLi st, individual
radio burtons are defined by ListItem elements. Note that, like the DropDownList Tasks
smart tag menu, the RadioButtonList Tasks smart tag menu also provides an Edit hems...
link to open the Listitem Collection Editor.

The final web control in Fig. 25.13 is a Button (lines 99—100). A Button web control
represents a burton that triggers an action when clicked. This control typically maps to an
XHTML input element with artribute type set to "submit”. As stated eatlier, clicking the
Reglster button in this example does not do anything.

Fﬁsuﬂ Basic 2006 How to Program

Fig. 25.14 | DropDownList Tagks smart tag menu.

25.3.2 AdRotator Control

Web pages often contain product or service advertisements, which usually consist of
images. Although website authors want to include as many sponsors as possible, web pages
can display only a limited number of advertisements. To address this problem, ASP.NET
provides the AdRotator web control for displaying advertisements. Using advertisement
data located in an XML file, an AdRotator randomly selects an image to display and gen-
erates a hyperlink to the web page associated with that image. Browsers thar do not support
images display alternate text that is specified in the XML document. If a user clicks the
image or substituted text, the browser loads the web page associated with that image.

Demonstrating the AdRotator Web Control
Figure 25.15 demonstrates the AdRotator web control. In this example, the “advertise-
ments” that we rotate are the flags of 10 countries. When a user clicks the displayed flag
image, the browser is redirected to a web page containing information about the country
that the flag represents. If a user refreshes the browser or requests the page again, one of
the 10 flags is again chosen at random and displayed.

The ASPX file in Fig. 25.15 is similar to that in Fig. 25.1. However, instead of
XHTML text and 2 Label, this page contains XHTML text (the h3 element in line 16)
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and an AdRotator control named countryRotator (lines 18-19). This page also contains
an Xm1DataSource control (lines 20-22), which supplies the data to the AdRotator con-
trol. The background artribute of the page’s body element (line 13) is ser to the image
background. png, located in the project’s Images folder. To specify this file, click the
ellipsis provided next to the Background property of DOCUMENT in the Properties window
and use the resulting dialog to select background. png from the Images folder. The images
and XML file used in this example are both located in the chapter’s examples directory.
You do not need to add any code to the code-behind file, because the AdRotator cont-
rol “does all the work.” The output depicts two different requests. Figure 25.15(a) shows

Fig. 25.15 | Web Form that demonstrates the AdRotator web control. (Part | of 2.)
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Fig. 25.15 | Web Form that demonstrates the AdRotator web control. (Part 2 of 2.)

the first time the page is requested, when the American flag is shown. In the second request,
as shown in Fig. 25.15(b), the French flag is displayed. Figure 25.15(c} depicts the web
page that loads when the French flag is clicked.

-Connecting Data to an AdRotator Control

An AdRotator control accesses an XML file (presented shortly) to determine what adver-
tisement (i.e., flag) image, hyperlink URL and alternate text to display and include in the
page. To connect the AdRotator control to the XML file, we create an XmiDataSource
control—one of several ASP.NET data controls (found in the Data section of the Toolbox)
that encapsulate data sources and make such data available for web controls. An Xm1Data-
Source references an XML file containing data that will be used in an ASP.NET applica-
tion. Later in the chapter, you will learn more about dara-bound web controls, as well as
the Sq1DataSource control, which retrieves data from a SQL Server database, and the
ObjectDataSource control, which encapsulates an object that makes data available.

To build this example, we first add the XML file AdRotatorInformation.xm1 to the
project. Each project created in Visual Web Developer contains an App_Data folder, which
is intended to store all the data used by the project. Right click this folder in the Solution
Explorer and select Add Existing Item..., then browse for AdRotatorInformation.xml on
your computer. We provide this file in the chapter’s examples directory in the subdirectory
named exampleXMLFiles.

After adding the XML file to the project, drag an AdRotator control from the Toolbox
to the Web Form. The AdRotator Tasks smart tag menu will open automatically. From
this menu, select <New Data Source...> from the Choose Data Source drop-down list to start
the Data Source Configuration Wizard. Select XML File as the data-source type. This causes
the wizard to create an Xm1DataSource with the ID specified in the bottom half of the
wizard dialog. We set the ID of the control to adxmiDataSource. Click OK in the Data
Source Configuration Wizard dialog. The Configure Data Source - adXmiDataSource dialog
appears next, In this dialog’s Data File section, click Browse... and, in the Select XML File
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dialog, locate and select the XML file you added to the App_Data folder. Click OK to exit
this dialog, then click OK to exit the Configure Data Source - adXmiDataSource dialog.
After completing these steps, the AdRotator is configured to use the XML file to determine
which advertisements to display.

Examining an XML File Containing Advertisement Information
XML document AdRotatorInformation.xml (Fig. 25.16)—or any XML document used
with an AdRotator control——must contain one Advertisements root element (lines 4—
94). Within that element can be several Ad elements (e.g., lines 5-12), each of which pro-
vides information about a different advertisement, Element Inagetri (line 6) specifies the
path (location) of the advertisement’s image, and element Navigatetr (lines 7-9) speci-
fies the URL for the web page that loads when a user clicks the advertisement. Note that
we reformatted this file for presentation purposes. The actual XML file cannot con-tain
any whitespace before or after the URL in the Navigateur] element, or the whitespace will
be considered part of the URL, and the page will not load properly.

~The AlternateText element {line 10) nested in each Ad element contains text that
displays in place of the image when the browser cannot locate or render the image for some
reason (i.e., the file is missing, or the browser is not capable of displaying it), or to assist
the visually impaired. The AlternateText element’s text is also a tooltip that Internet
Explorer displays when a user places the mouse pointer over the image (Fig. 25.15). The
Impressions element (line 11) specifies how often a particular image appears, relative to
the other images. An advertisement that has a higher Impressions value displays more fre-
quently than an advertisement with a lower value. In our example, the advertisements dis-
play with equal probability, because the value of cach Impressions element is set to 1.

Fig. 25.16 | XML file containing advertisement information used in AdRotator example. (Part 1
of 3.)
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Fig. 25.16 | XML file containing advertisement information used in AdRotator example. {Part 3
of 3.)

25.3.3 Validation Controls

This section introduces a different type of web control, called a validation control (or val-
idator), which determines whether the data in another web control is in the proper formar.
For example, validators could determine whether a user has provided information in a
required field or whether a zip-code field contains exactly five digits. Validators provide a
mechanism for validating user input on the client. When the XHTML. for our page is cre-
ated, the validaror is converted into JavaScripe that performs the validation. However, some
clients do nort support scripting or disable scripting. So, for security reasons, validation is
always performed on the server too—whether or not scripting is enabled on the client. For
this example, we assume the client has JavaScript enabled.

Validating Input in a Web Form
The example in this section prompts the user to enter a name, e-mail address and phone
number. A website could use a form like this to collect contact information from site vis-
itors. After the user enters any data, but before the dara is sent to the web server, validators
ensure that the user entered a value in each field and that the e-mail address and phone
number values are in an acceptable format. In this example, (555) 123-4567, 555-123-
4567 and 123-4567 are all considered valid phone numbers. Once the data is submitted,
the web server responds by displaying an appropriate message and an XHTML table
repeating the submitted information. Note that a real business application would typically
store the submitted data in a database or in a file on the server. We simply send the data
back to the form to demonstrate that the server received the data.

Figure 25.17 presents the ASPX file. Like the Web Form in Fig. 25.13, this Web
Form uses a table to organize the page’s contents. Lines 24-25, 36-37 and 5859 define
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TextBoxes for retrieving the user’s name, e-mail address and phone number, respectively,
and line 78 defines a Submit butron. Lines 8082 create a Labe1 named outputiabel that
displays the response from the server when the user successfully submits the form. Notice
that outputLabel’s Visible property is initially set to False (line 81), so the Label does
not appear in the client’s browser when the page loads for the first time.

Using RequiredFieldValidator Controls

In this example, we use three RequiredFieldvalidator controls {found in the Validation
section of the Toolbox) to ensure thar the name, e-mail address and phone number Text-
Boxes are not empty when the form is submitted. A RequiredFieldvalidator makes an
input control a required field. If such a field is empty, validation fails. For example, lines
26-30 define RequiredFieldvalidator namelnputValidator, which confirms that
nameTextBox is not empty. Line 28 associates nameTextBox with nameInputvalidator by
setting the validator’s ControlTovalidate property to nameTextBox. 'This indicates that
nameInputvalidator verifies the nameTextBox’s contents. We set the value of this prop-
erty (and the validator’s other properties) by selecting the validator in Design mode and
using the Properties window to specify property values. Property ErrorMessage’s text (line
29) is displayed on the Web Form if the validation fails. If the user does not input any data
in nameTextBox and attempts to submit the form, the ErrorMessage text is displayed in
red. Because we set the validator’s Display property to Dynamic (line 28), the validator is
displayed on the Web Form only when validation fails. Space is allocated dynamically
when validation fails, causing the contrals below the validator to shift downward to
accommodate the ErrorMessage, as seen in Fig. 25.17(a)-(c).

Using RegularExpressionvalidator Controls

This example also uses RegularExpressionval idator controls to match the e-mail add-
ress and phone number entered by the user against regular expressions. These controls det-
ermine whether the e-mail address and phone number were each entered in a valid format.
For example, lines 44-51 create a RegularExpressionvalidator named emailFormat-
validator. Line 46 sets property ContralToValidate to emaiiTextBox to indicate that
emai1FormatValidator verifies the emailTextBox’s contents. '

o

Fig. 25.17 | Form that demonstrates using validators to validate user input. (Part | of 4.)
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Fig. 25.17 I Form that demonstrates using validators to validate user input. (Part 2 of 4.)
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Fig. 25.17 | Form that demonstrates using validators to validate user input. (Part 3 of 4.)
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Piease fil out the following form.
AN felds are reguired ond mysr contain valid information.

Nane:

?k-me enter an *-maa adéress ma uahd format.
Phone namber; E55-1

GM 0 @@ﬁﬂmg&mes@-&ﬂ L‘Jsﬁ.
. o

Please fill out the following form.
All ficlds are required and must contain valid biformation.

e.g.. wser@domain com
i eg,(555)555-1234

We received the following information:
Name: Bob White

E-mail address: bwhite/@ emad com
Phone oranber: (855) 555-1234

Fig. 25.§7 | Form that demonstrates using validators to validate user input. (Part 4 of 4.)

A RegularExpressionvalidator’s ValidationExpression property specifies the reg-
ular expression that validates the Contro1Tovalidate’s contents. Clicking the ellipsis next
to property ValidationExpression in the Properies window displays the Regular Expres-
sion Editor dialog, which contains a list of Standard expressions for phone numbers, zip
codes and other formatted information. You can also write your own custom expression.
For the emailFormatvalidator, we selected the standard expression Intermet e-mail
address, which uses the validarion expression

A\w+CE=+. TN @\ (- 1w "\ Aw (- \w ) *
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This regular expression indicates that an e-mail address is valid if the part of the address
before the @ symbol contains one or more word charactets (i.e., alphanumeric characters
or underscores), followed by zero or more strings comprised of a hyphen, plus sign, period
or apostrophe and additienal word characters. After the @ symbol, a valid e-mail address
must contain one or more groups of word characters potentially separated by hyphens or
periods, followed by a required period and another group of one or more word characters
potentially separated by hyphens or periods. For example, bob.whiteGemail.com, bob-
white@my-email.com and bob's-personal.email@white.email.com are all valid e-mail
addresses. If the user enters text in the emai 1TextBox that does not have the correct format
and either dicks in a different text box or attempts to submit the form, the ErrorMessage
text is displayed in red. You can learn more about regular expressions ar www. regular-
expressions.info.

We also use RegularExpressionvalidator phoneFormatValidator (lines 66-73) to
ensure that the phoneTextBox contains a valid phone number before the form is sub-
mitted. In the Regular Expression Editor dialog, we select U.S. phone number, which assigns

(A3 1 (\d{3}-D)7\d{3}-\d{4}

to the ValidationExpression property. This expression indicates that a phone number
can contain a three-digit area code either in parentheses and followed by an optional space
or without parentheses and followed by required hyphen. After an optional area code, a
phone number must contain three digits, a hyphen and another four digits. For example,
(555) 123-4567, 555-123-4567 and 123-4567 are all valid phone numbers.

If all five validators are successful (i.e., each TextBox is filled in, and the e-mail address
and phone number provided are valid), clicking the Submit button sends the form’s data
10 the server. As shown in Fig. 25.17(d), the server then responds by displaying the sub-
mitted data in the outputLabel (lines 80-82).

Examining the Code-Bebind File for a Web Form That Receives User Input

Figure 25.18 depicts the code-behind file for the ASPX file in Fig, 25.17. Notice that this
code-behind file does not contain any implementation related to the validators. We say
more about this soon.

Fig. 25.18 | Code-behind file for the form demonstrating validation controls. (Part | of 2.)
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Fig. 25.18 | Code-behind file for the form demonstrating validation controls. (Part 2 of 2.)

Web programmers using ASP.NET often design their web pages so that the current
page reloads when the user submits the form; this enables the program to receive input,
process it as necessary and display the results in the same page when it is loaded the second
time. These pages usually contain a form that, when submitted, sends the values of all the
controls to the server and causes the current page to be requested again. This event is
known as a postback. Line 11 uses the IsPostBack property of class Page to determine
whether the page is being loaded due to a postback. The first time that the web page is
requested, IsPostBack is False, and the page displays only the form for user input. When
the postback occurs (from the user clicking Submit), IsPostBack is True.

Lines 1315 retrieve the values of nameTextBox, emailTextBox and phoneTextBox.
When data is posted to the web server, the XHTML form’s data is accessible to the web
application through the properties of the ASP.NET controls. Lines 18-24 append to out-
putLabel’s Text a line break, an additional message and an XHTML table containing the
submitted dara, so the user knows that the server received the dara correctly. In a real busi-
ness application, the data would be stored in a database or file ac this point in the applica-
tion. Line 25 sets the outputLabel’s Visible property to True, so the user can see the
thank you message and submitted data.

Examining the Client-Side XHTML for a Web Form with Validation

Figure 25.19 shows the XHTML and ECMAScript sent to the client browser when val-
jdation.aspx loads after the postback. (We added the comments in lines 1-2.) To view
this code, select View > Source in Internet Explorer. Lines 27-55, lines 126-190 and lines
196-212 contain the ECMAScript that provides the implementation for the validation
controls and for performing the postback. ASP.NET generates this ECMAScript. You do
not need to be able to create or even understand ECMAScript—the functionality defined
for the controls in our application is converted to working ECMAScript for us.

The EnableViewState attribute determines whether a web control’s value is retained
when a postback occurs. Previously, we explicitly set this artribute to Faise. The defaule
value, True, indicates that the control’s value is retained. In Fig. 25.17(d), notice thar the
user input is retained after the postback occurs. A hidden input in the XHTML document
(lines 17-25 of Fig. 25.19) contains the data of the controls on this page. This element is
always named _ VIEWSTATE and stores the controls’ data as an encoded string.
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nput type== hidden" name="__ VIEWSTATE" id="_ VIEWSTATE™

_values’ /wEPDwUJMzgtmDIlNzgzDzQHAgIDDZQWAgITDwSNBMEVGWdMA? Ro
-WS_rIH'I vd_SmeB_]IgeHle Bzdw

b3ciP F 2T 'Pcsemmmﬁ
C%ZD“LBRVPchdeMRSItW]SIG KZHIT < 3MBIDwvd(

Fig. 25.19 | XHTML and ECMAScript generated by ASP.NET and sent to the browser when
Validation,aspx is requested. (Part | of 5.)
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Fig. 25.19 | XHTML and ECMAScript generated by ASP.NET and sent to the browser when
validation.aspx is requested. (Part 2 of 5.}
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Fig. 25.19 | XHTML and ECMAScript generated by ASP.NET and sent to the browser when
Validation.aspx is requested. (Part 3 of 5.)
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Fig. 25.19 | XHTML and ECMAScript generated by ASP.NET and sent to the browser when
Validation.aspx is requested. {Part 4 of 5.)



1012 Internet & World Wide Web How to Program

Fig. 25.19 | XHTML and ECMAScript generated by ASP.NET and sent to the browser when
validation.aspx is requested. (Part 5 of 5.}

Performance Tip 25.1

Setting EnableViewState to False reduces the amount of data passed to the web server with
each request.

Software Engineering Observation 25.2

Client-side validation cannot be trusted by the server because there are too many ways top
circumvent client-side validation. For this reason, all important validation should be peformed
on the server,

25.4 Session Tracking

Originally, critics accused the Interner and e-businesses of failing to provide the kind of
customized service typically experienced in “brick-and-mortar” stores. To address this
problem, e-businesses began to establish mechanisms by which they could personalize
users’ browsing experiences, railoring content to individual users while enabling them to
bypass irrelevant information. Businesses achieve this level of service by tracking each
customer’s movement through the Internet and combining the collected data with infor-
mation provided by the consumer, including billing information, personal preferences,
interests and hobbies.

Personalization

Personalization makes it possible for e-businesses to communicate effectively with their
customers and also improves users’ ability to locate desired products and services. Compa-
nies thar provide content of particular interest to usets can establish relationships with cus-
tomers and build on those relationships over time. Furthermore, by rargeting consumers
with personal offers, recommendations, advertisements, promotions and services, e-busi-
nesses create customer loyalry. Websites can use sophisticated technology to allow visitors
to customize home pages to suit their individual needs and preferences. Similarly, online
shopping sites often store personal information for customers, tailoring notifications and
special offers to their interests. Such services encourage customers to visir sites more fre-
quently and make purchases mote regularly.
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Privacy

A trade-off exists, however, between personalized e-business service and protection of pri-
vacy. Some consumers embrace the idea of tailored content, bur others fear the possible
adverse consequences if the info they provide to e-businesses is released or collected by
tracking rechnologies. Consumers and privacy advocates ask: What if the e-business to
which we give personal data sells or gives that information to another organization without
our knowledge? What if we do not want our actions on the Interner—a supposedly anon-
ymous medium—to be tracked and recorded by unknown parties? Wha if unauthorized
parties gain access to sensitive private dara, such as credit card numbers or medical history?
All of these are questions that must be debated and addressed by programmers, Consurmers,
e-businesses and lawmakers alike,

Recognizing Clients
To provide personalized services to consumers, e-businesses must be able to recognize clie-
nts when they request information from a site. As we have discussed, the request/ response
system on which the web operates is facilitated by HTTP. Unfortunately, HTTP is a state-
less protocol. This means that web servers cannot determine whether a request comes from
a particular client or whether the same or different clients gencrate a series of requests.

To circumvent this problem, sites can use the concept of a “session” to identify indi-
vidual clients. A session represents a unique client on a website. If the client leaves a site
and then returns later, the client will still be recognized as the same user. To help the server
distinguish among clients, each client must identify itself to the server. Tracking indi-
vidual clients, known as session tracking, can be achieved in a number of ways. One popu-
lar technique uses cookies (Section 25.4.1); another uses ASP.NET’s HrtpSessionState
object (Section 25.4.2). Additional session-tracking techniques include the use of input
form elements of type "hidden" and URL rewriting. Using "hidden” form elements, a
Web Form can write session-tracking data into a form in the web page that it returns to
the client in response to a prior request. When the user submits the form in the new web
page, ail the form dara, including the "hidden" fields, is sent to the form handler on the
web server. When a website performs URL rewriting, the Web Form embeds session-
tracking information directly in the URLs of hyperlinks that the user clicks to send subse-
quent requests to the web server.

Note that our previous examples set the Web Form’s EnableSessionState propetty
to False. However, because we wish to use session tracking in the following examples, we
keep this property’s defaule serting—True.

25.4.1 Cookies

Coolkies provide web developers with a tool for identifying and tracking web users. A
cookie is a piece of dara stored in a small rext file on the user’s computer. A cookie main-
tains information about the client during and between browser sessions. The first time a
user visits the website, the user’s computer might receive a cookie; this cookie is then ret-
rieved each time the user revisits that site. The collected information is intended to be an
anonymous record containing data that is used to personalize the user’s future visirs to the
site. For example, cookies in a shopping application might store unique identifiers for
usets. When a user adds items to an online shopping cart or performs another task result-
ing in a request to the web server, the server receives a cookie containing the user’s unique
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idencifier. The server then uses the unique identifier to locate the shopping cart and per-
form any necessary processing.

In addition to identifying users, cookies also can indicate users’ shopping preferences.
When a web server receives a request from a client, the server can examine the cookie(s) it
sent to the client during previous communications, identify the users’s preferences and
immediately return products of interest to the client.

Every HTTP-based interaction between a client and a server includes a header con-
tining information either about the request (when the communication is from the client
to the server) or about the response (when the communication is from the server to the
client). When a web server receives a request, the header includes information such as the
request type (e.g., Get) and any cookies that have been sent previously from the server to
be stored on the client machine. When the server formulates its response, the header infor-
marion contains any cookies the server wants to store on the client computer and other
information, such as the MIME type of the response.

The expiration date of a cookie determines how long the cookie remains on the
client’s computer. If you do not set an expiration date for a cookie, the web browser main-
tains the cookie for the duration of the browsing session. Otherwise, the Web browser
maintains the cookie until the expiration date occurs. When the browser requests a
resource from a web server, cookies previously sent to the client by that Web server are
returned to the web server as part of the request formulated by the browser. Cookies are
deleted when they expire.

Portability Tip 25.3
ﬂ Users may disable cookies in their browsers to ensure that their privacy is protected. Such wsers
will experience difficulty using sites that depend on cookies to mainsain stase information.

Using Cookies to Provide Book Recommendations

The next web application demonstrates the use of cookies. The example contains two
pages. In the first page (Figs. 25.20-25.21), users select a favorite programming language
from a group of radio butrons and submit the XHTML form to the web server for pro-
cessing. The web server responds by creating a cookie that stores a record of the chosen
language, as well as the ISBN number for a book on that topic. The server then returns an
XHTML document to the browser, allowing the user either to select another favorite pro-
gramming language or to view the second page in our application (Figs. 25.22-25.23),
which lists recommended books pertaining to the programming language thac the user sel-
ected previously. When the user clicks the hyperlink, the cookies previously stored on the
client are read and used to form the list of book recommendations.

The ASPX file in Fig, 25.20 contains five radio buttons (lines 20—26) with the values
Visual Basic 2005, Visual C# 2005, C, C++, and Java. Recall that you can set the values of
radio buttons via the Listitem Collection Editor, which you open cither by clicking the
RadioButtonList’s Items property in the Properties window or by clicking the Edit
ltems... link in the RadioButtonList Tasks smart tag menu. The user selects a programming
language by clicking one of the radio buttons. When the user clicks Submit, we'll create 2
cookic containing the selected language. Then, we'll add this cookie to the HTTP
response header, so the cookie will be stored on the user’s compuer. Each time the user
chooses a language and clicks Submit, a cookie is written to the client. Each time the client
requests information from our web application, the cookies are sent back to the server.
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When the postback occurs, certain controls are hidden and others are displayed. The
Label, RadioButtonList and Button used to select a language are hidden. Toward the
bottom of the page, a Labe1 and two HyperLinks are displayed. One link requests this page
(lines 32-33), and the other requests Recommendations.aspx (lines 37—40). Clicking the
first hyperlink (the one that requests the current page) does not cause a postback to occur.
The file Options.aspx is specified in the NavigateUr1 property of the hyperlink. When
the hyperlink is clicked, a new request for this page occurs. Recall that earlier in the
chapter, we set NavigateUr] to a remote website (http://www.deitel.com). To set this
property to a page within the same ASP.NET application, click the ellipsis button next to
the NavigateUr] property in the Properties window to open the Select URL dialog. Use
this dialog 1o select a page within your project as the destination for the Hypertink.

</asp: Rad1 oButtonu s't>

asp:HyperLink ID="languageLink” runat="server"
Navigatellri="~/Options.aspx"” Visible="False"
Click ‘here to choose another 1anguage
</aspiHyperlinks<br />

asp: Hyperl.'ink ID=“r' ommendationsli nk" runat="server‘"

talirl=' datieons.:
TS

Fig. 25.20 | ASPX file that presents a list of programming languages. (Part | of 2.)
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Fig. 25.20 | ASPXiile that presents a list of programming languages. (Part 2 of 2.}

Adding and Linking to a New Web Form

Setting the Navigatelr1 property to a page in the current application requires that the
destination page exist already. Thus, to set the NavigateUr1 property of the second link
{the one that requests the page with book recommendations) to Recommendations.aspx,
you must first create this file by right clicking the project location in the Solution Explorer
and selecting Add New ltem.., from the menu that appears. In the Add New ltem dialog,
select Web Form from the Templates pane and change the name of the file to Recommen-
dations.aspx. Finally, check the box labeled Place code In separate file to indicate that
the IDE should create a code-behind file for this ASPX file. Click Add to create the file.
(We discuss the contents of this ASPX file and code-behind file shortly.) Once the Recom-
mendations . aspx file exists, you can select it as the Navigatelr1 value for a HyperLink in
the Select URL dialog. '
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Writing Cookies in a Code-Behind File

Figure 25.21 presents the code-behind file for Options.aspx (Fig. 25.20). This file con-
tains the code that writes a cookie to the client machine when the user selects a program-
ming language. The code-behind file also modifies the appearance of the page in response

to a postback.

: :Basic 2005",  "0-13-186900-0
5ﬂ31 C#EZOGS" -"0 13 152523~ 9") :

the user made a selection, display 11-in ves
uageL'ist Se‘fectedrtem IsNor Nﬂthmg Thcn’

responset.abe'[ Taxt & ™ You d1d not se1ect al

Fig. 25.21 | Code-behind file that writes a cookie to the client. (Part | of 2.)
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add cookie to response:to place
esponse . Cookies.Add(cookie) - ~ -

Fig. 25.21 | Code-behind file that writes a cookie to the client. {Part 2 of 2.)

Line 7 creates variable books as a Hashtable (namespace System.Collections)—a
data structure that stores key—value pairs. A program uses the key to store and retrieve the
associated value in the Hashtable. In this example, the keys are strings containing the
programming languages’ names, and the values are strings containing the ISBN numbers
for the recommended books. Class Hashtable provides method Add, which takes as argu-
ments a key and a value. A value that is added via method Add is placed in the Hashtable
at a location determined by the key. The value for a specific Hashtable entry can be deter-
mined by indexing the Hashtable with that value’s key. The expression

HashtableName(keyName)

returns the value in the key—value pair in which keyName is the key. For example, the
expression books (1anguage) in line 54 returns the value that corresponds to the key con- -
tained in 1anguage.

Clicking the Submit button creates a cookie if a language is selected and causes a post-
back to occur. In the submitButten_Click event handler (lines 47—62), a new cookie
object (of type HttpCookie) is created to store the Tanguage and its corresponding ISBN
number (line 57). This cookie is then Added to the Cookies collection sent as part of the
HTTP response header (line 60). The postback causes the condition in the If statement
of Page_Load (line 24) to evaluate to True, and lines 27-42 execute. Lines 27-29 reveal
the initially hidden controls responseLabel, languageLink and recommendationsLink.
Lines 32—34 hide the controls used to obtain the user’s language selection. Line 37 deter-
mines whether the user selected a language. 1If so, that language is displayed in response-
Label (lines 38-39). Otherwise, text indicating that a language was not selected is
displayed in responselabel (line 41).

Displaying Book Recommendations Based on Cookie Values

After the postback of Options.aspx, the user may request a book recommendation.
The book recommendation hyperlink forwards the user to Recommendations.aspx
(Fig. 25.22) to display the recommendations based on the user’s language selections.
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asp:ListBox | Bﬁ_"h‘o
Width="450px"></asp

Fle Edt: Vew Pavoribes Tools Help

Q- 9 W@ B P

Recommendations

Visual Bagic 2005 How to Program. |SBNS: 0-13-186900-0
C++ How to Program. [SBN# G-13-185757-6

Fig. 25.22 | ASPX file that displays book recommendations based on cookies.

Recommendations.aspx contains a Label (lines 16-18), a ListBox (lines 20-21) and
a HyperLink (lines 23-26). The Label displays the text Recommendations if the user
selects one or more languages; otherwise, it displays No Recommendations. The ListBox
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displays the recommendations specified by the code-behind file (Fig. 25.23). The Hyper-
Link allows the user to return to Options.aspx to select additional languages.

Code-Behind File That Creates Book Recommendations from Cookies

In the code-behind file (Fig. 25.23), method Page_Init (lines 7-28) retrieves the cookies
from the client, using the Request object’s Cookies property (line 10). This returns a col-
lection of type HttpCookieCollection, containing cookies that have previously been writ-
ten to the client. Cookies can be read by an application only if they were created in the
domain in which the application is running-—-a web server can never access cookies created
outside the domain associated with that server. For example, a cookie created by a web
server in the deitel.com domain cannot be read by a web server in any other domain.
[Nose: Depending on the settings in web. config and whether other pages store cookies,
other cookie values may be displayed by this web application.]

Line 13 determines whether at least one cookie exists. Lines 14-17 add the informa-
tion in the cookie(s} to the booksListBox. The Toop retrieves the name and value of each
cookie using 1, the loop’s control variable, to determine the current value in the cookie
collection. The Name and Value properties of class HttpCookie, which contain the lan-
guage and corresponding ISBN, respectively, are concatenated with " How to Program.

booksListBox.Items,.Add(cookies(i).Name & _

" How to Program ISBN#

Fig. 25.23 | Reading cookies from a client to determine book recommendations.
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ISBN# " and added to the ListBox. Lines 21-26 execute if no language was selected. We
summarize some commonly used HttpCookie properties in Fig. 25.24.

AR B

Fig. 25.24 | HttpCookie properties.

25.4.2 Session Tracking with HttpSessionState

Session-tracking capabilities are provided by the FCL class HttpSessionState. To demo-
nstrate basic session-tracking techniques, we modified the example of Figs. 25.20-25.23
to use HttpSessionState objects. Figures 25.25-25.26 present the ASPX file and code-
behind file for Options.aspx. Figures 25.28-25.29 present the ASPX file and code-beh-
ind file for Recommendations.aspx. Options.aspx is similar to the version presented in
Fig. 25.20, but Fig. 25.25 contains two additional Labels (lines 32-33 and lines 35-36),
which we discuss shortly.

Every Web Form includes an HttpSessionState object, which is accessible through
property Session of class Page. Throughout this section, we use property Session to
manipulate our page’s HttpSessionState object. When the web page is requested, an
HttpSessionState object is created and assigned to the Page’s Session property. As a
result, we often refer to property Session as the Session object.

Adding Session Items

When the user presses Submit on the Web Form, submitButton_Click is invoked in the
code-behind file (Fig. 25.26, lines 55-66). Method submitButton_Click responds by
adding a key—value pair to our Session object, specifying the language chosen and the
ISBN number for a book on that language. These key—value pairs are often referred to as
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session items. Next, a postback occurs. Each time the user clicks Submit,
submitButton_C1ick adds a new session item to the HttpSessionState object. Because
much of this example is identical to the last example, we concentrate on the new features.

R R
<asp:iabel ID="idLabel™ runat—"server" V1sib_e=
</asp:Labels><br /> : ) :

<aspilabel ID="timeoutLabel” runat="server" V1s1b1en'F1se
</asp:label»<br />

Fig. 25.25 | ASPX file that presents a list of programming languages. (Part | of 2.)
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Re ot Vew Fowrtes Tok o .
Ok~ 5 - M B H Ssert rovoms
[ —

Welcome to sessions! You selected Visual C# 2008

O Visoul Basic 2005 Your veegue session 1D is. dvdiqedSalocymsSSoekeeZy
@ Visul C¥ 2005
oc ; Tmeout: 20 mimnies.

gjch heve 10 & another lan;
v
Click here to get book recommendntions

Mds ~§}5majhalmmwmmmwl

Welcome to sessions! You selected C++
Your waque session 1D is: dydqgd5abocymS 5 Sockec2y
Taneout: 20 mimtes.

Cheke here 1o choose another bmgnags

~ Eb_. -

Fig. 25.25 | ASPX file that presents a list of programming languages. (Part 2 of 2.)

Software Engineering Observation 25.3

A Web Form showld not use instance variables to mainiain client state information, because each
new request or postback is handled by a new instance of the page. Instead, maintain client state
information in HtpSessionState objects, because such objects are specific to each client.

Like a cookie, an HttpSessionState object can store name—value pairs. These session
items are placed in an HrtpSessionState object by calling method Add. Line 64 calls Add
to place the language and its corresponding recommended book’s ISBN number in the
HttpSessionState object. If the application calls method Add to add an attribute that has
the same narme as an attribute previously stored in a session, the object associated with that
awribute is replaced.

Software Engineering Observation 25.4

W A benefir of using HrtpSessionState objects (rather than cookies) is that HttpSessionState
® objects can store any type of object (not just Strings) as attribute values. This provides you with
increased flexibility in determining the type of state information to maintain for clients.
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display the timeout

[

imeoutiabel

Fig. 25.26 | Processes user's selection of a programming language by displaying links and
writing information in a Session object. (Part | of 2.)
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Session.Add(language, ISBN} ' add name/value pair to S

Fig. 25.26 | Processes user's selection of a programming language by displaying links and
writing information in a Session object. (Part 2 of 2.)

The application handles the postback event (lines 24-51) in method Page_Load.
Here, we retrieve information about the current client’s session from the Session object’s
propertics and display this information in the web page. The ASP.NET application con-
tains informartion about the HttpSessionState object for the current client. Property
SessionID (line 47) contains the unique session ID—a sequence of random letters and
numbers. The first time a client connects to the web server, a unique session ID is created
for thar client and a temporary cookie is written to the client so the server can identify the
client on subsequent requests. When the client makes additional requests, the client’s ses-
sion ID from that temporary cookie is compared with the session IDs stored in the web
server’s memory to retrieve the client’s HttpSessionState object. Recall that clients may
disable cookies in their web browsers to ensure that their privacy is protected. Such clients
will experience difficulty using web applications that depend on HttpSessionState
objects and cookies to maintain state information. The HttpSessionStrate property
IsCookieless indicates whether URL rewriting or cookies are used for session tracking,
Property Timeout (line 50) specifies the maximum amount of time that an Http-
SessionState object can be inactive before it is discarded. Figure 25.27 lists some
common HttpSessionState properties.

Fig. 25.27 | HrtpSessionState properties. (Part | of 2.)
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Fig. 25.27 | HttpSessionState properties. (Part 2 of 2.)

Displaying Recommendations Based on Session Values

As in the cookies example, this application provides a link to Recommendations.aspx
(Fig. 25.28), which displays a list of book recommendations based on the uset’s language
selections. Lines 20-21 define a ListBox web control thart is used 1o present the recom-
mendations to the user.

Fig. 25.28 | Session-based book recommendations displayed in a ListBox. (Part | of 2.)
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Recommendations

Visual GF 2005 How 16 Program 1SBIG 0.13.162593.9
C4-+ How to Program, ISBNE: 0-13-1857576

Click bere to choose another langnage

Fig. 25.28 | Session-based book recommendations displayed in a ListBox. (Part 2 of 2.)

Code-Behind File That Creates Book Recommendations from a Session

Figure 25.29 presents the code-behind file for Recommendations.aspx. Event handler
Page_Init (lines 7-30) retrieves the session information. If a user has not selected a lan-
guage on Options.aspx, our Session object’s Count property will be 0. This property pro-
vides the number of session items contained in a Session object. If Session object’s Count

property is 0 (i.e., no language was selected), then we display the text No Recommendations
and update the Text of the HyperLink back to Options.aspx.

Fig. 25.29 | Session data used to provide book recommendations to the user. (Part { of 2.)
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Fig. 25.29 | Session data used to provide book recommendations to the user. (Part 2 of 2.)

If the user has chosen a language, the loop in lines 11-19 iterates through our Session
object’s session items, temporarily storing each key name (line 13). The value in a key—
value pair is retrieved from the Session object by indexing the Session object with the
key name, using the same process by which we retrieved a value from our Hashtable in
the preceding section.

Line 13 accesses the Keys property of class HttpSessionState, which returns a collec-
tion containing all the keys in the session. Line 13 indexes this collection to retrieve the
current key. Lines 16-18 concatenate keyName’s value to the String " How to Program.
ISBN#: " and the value from the Session object for which keyName is the key. This String
is the recommendation that appears in the ListBox.

25.5 Case Study: Connecting to a Database in ASP.NET

Many websites allow users to provide feedback abourt the website in a guestbook. Typica-
lly, users click a link on the website’s home page to request the guestbook page. This page
usually consists of an XHTML form that contains fields for the user’s name, e-mail add-
ress, message/feedback and so on. Dara submitted on the guestbook form is then stored
in a database located on the web server’s machine.

In this section, we create a guestbook Web Form application. This example’s GUT is
slightly more complex than that of earlier examples, It contains a Gridview ASP.NET dara
control, as shown in Fig. 25.30, which displays all the entries in the guestbook in tabular
format. We explain how to create and configure this data control shortly. Note that the
Gridview displays abe in Design mode to indicate string data that will be retrieved from a
data source at runtime.

The XHTML form presented to the user consists of a name field, an e-mail address
field and a message field. The form also contains a Submit button to send the data to the
server and a Ciear button to reset each of the fields on the form. The application stores the
guestbook information in a SQL Server database called Guestbook .mdf located on the web
server, (We provide this database in the examples directory for this chapter. You can
download the examples from www.deitel.com/books/iw3htp4.) Below the XHTML
form, the Gridview displays the data (i.e., guestbook entries) in the database’s Messages
table.
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Fig. 25.30 | Guestbook application GUI in Design mode.

25.5.1 Building a Web Form That Displays Data from a Database

We now explain how to build this GUI and set up the data binding between the Gridview
control and the darabase. We present the ASPX file generated from the GUI later in the
section, and we discuss the related code-behind file in the next section. To build the guest-
book application, perform the following steps:

Step 1: Creating the Project

Create an ASP.NET Web Sie named Guesthook and name the ASPX file Guestbook .aspx.
Rename the class in the code-behind file Guestbook, and update the Page directive in the
ASPX file accordingly.

Step 2: Creating the Form for User Input

In Design mode for the ASPX file, add the text Please leave a message in our guest-
book: formatted as an h2 header. As discussed in Section 25.3.1, insert an XHTML table
with two columns and four rows, configured so that the text in each cell aligns with the
top of the cell. Place the appropriate text (see Fig. 25.30) in the top three cells in the table’s
left column. Then place TextBoxes named nameTextBox, emailTextBox and message-
TextBox in the top three table cells in the right column. Set messageTextBox to be a
multiline TextBox. Finally, add Buttons named submitButton and clearButton to the
bottom-right table cell. Set the buttons’ Text properties to Submit and Clear, respectively.
We discuss the buttons’ event handlers when we present the code-behind file.

Step 3: Adding a GridView Control to the Web Form

Add a Gridview named messagesGridview that will display the guestbook entries. This
control appears in the Data section of the Toolbox. The colors for the GridView are speci-
fied through the Auto Formet... link in the GridView Tasks smart tag menu that opens when
you place the Gridview on the page. Clicking this link causes an Auto Format dialog to
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open with several choices. In this example, we chose Simple. We soon show how 1o set the
GridView’s data source (i.e., where it gets the data to display in its rows and columns).

Step 4: Adding a Database to an ASP.NET Web Application

To use a SQL Server 2005 Express database in an ASP.NET web application, it is easiest
to first add it to the project’s App_Data folder. Righ click this folder in the Solution Exp-
lorer and select Add Existing ltem.... Locate the Guestbook.mdf file in the exampleData-
bases subdirectory of the chapter’s examples directory, then click Add.

Step 5: Binding the GridView to the Messages Table of the Guestbook Database
Now that the database is part of the project, we can configure the Gridview to display its
data. Open the GridView Tasks smart tag menu, then select <New data source...> from the
Choose Data Source drop-down list. In the Data Source Configuration Wizard that appears,
select Database. In this example, we use a Sq1DataSource control that allows the applica-
tion to interact with the Guestbook database. Ser the ID of the data source to messagesSql-
DataSource and click OK to begin the Configure Data Source wizard. In the Choose Your
Data Connection screen, select Guestbook.mdf from the drop-down list (Fig. 25.31), then
click Next > twice to continue to the Configure the Selact Statement screen.

The Configure the Select Statement screen (Fig. 25.32) allows you to specify which
data the Sq1DataSource should retrieve from the database. Your choices on this page
design a SELECT statement, shown in the bottom pane of the dialog. The Name drop-down
list identifies a table in the database. The Guestbook database contains only one table
named Messages, which is selected by default. In the Columns pane, click the checkbox
marked with an asterisk (*) to indicate that you want to retrieve the data from all the col-
umns in the Message table. Click the Advanced button, then check the box next to

Fig. 25.31 | Configure Data Source dialog in Visual Web Developer.
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! i ..,  Configure the Select Statement

Fig. 25.32 | Configuring the SELECT statement used by the Sg1DataSource to retrieve
data.

Generate UPDATE, INSERT and DELETE statements. This configures the SqiDataSource
control to allow us to change dara in, insert new data into and delete data from the data-
base. We discuss inserting new guestbook entries based on users’ form submissions shortly.
Click OK, then click Next > to continue the Configure Data Source wizard.

The next screen of the wizard allows you to test the query that you just designed. Click
Test Query to preview the dara that will be retrieved by the SqlDataSource (shown in
Fig. 25.33).

Finally, click Finish to complete the wizard. Notice thar a control named messages-
Sq1DataSource now appears on the Web Form directly below the Gridview (Fig. 25.34).
This control is represented in Design mode as a gray box containing its type and name.
This control will 7ot appear on the web page—the gray box simply provides a way to
manipulate the control visually through Design mode. Also notice that the Gridview now
has column headers that correspond to the columns in the Messages table and that the
rows each contain either a number (which signifies an autoincremented column) or abe
{which indicates string data). The actual data from the Guestbook database file will appear
in these rows when the ASPX file is executed and viewed in a web browser.

Step 6: Modifying the Columns of the Data Source Displayed in the GridView

It is not necessary for site visitors to see the MessageID column when viewing past guest-
book entries—rthis column is merely a unique primary key required by the Messages table
within the database. Thus, we modify the GridView so that this column does not display
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[iove the sitet Keep up the good worki
Vary useful information. Wil visik again soon.

Fig. 25.34 | Design mode displaying SqDataSource control fora Gridview.
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on the Web Form. In the GrigView Tasks smart tag menu, click Edit Columns. In the res-
ulting Fields dialog (Fig. 25.35), select MessagelD in the Selected fields pane, then click the
X. This removes the MessageID column from the Gridview. Click OK to return to the
main [DE window. The Gridview should now appear as in Fig. 25.30.

Fig. 25.35 | Removing the MessageID column from the GridView.

Step 7: Modifying the Way the Sq1DataSource Control Inserts Data

When you create a Sq1DataSource in the manner described here, it is configured to permit
INSERT SQL operations against the database table from which it gathers data. You must
specify the values to insert either programmatically or through other controls on the Web
Form. In this example, we wish 1o insert the data entered by the user in the nameTextBox,
emai1TextBox and messageTextBox controls. We also want to insert the current date—we
will specify the date to insert programmatically in the code-behind file, which we present
shortly.

To configure the Sq1DataSource to allow such an insertion, select the messagessql-
DataSource control then click the ellipsis button next to the control’s InsertQuery prop-
erty of the messagesSqlDataSource contro} in the Properties window. The Command and
Parameter Editor (Fig. 25.36) that appears displays the INSERT command used by the Sq1-
DataSource control. This command contains parameters @Date, @Name, @Email and
@Message. You must provide values for these parameters before they are inserted into the
database. Each parameter is listed in the Parameters section of the Command and Param-
eter Editer. Because we will set the Date parameter programmatically, we do not modify it
here. For each of the remaining three parameters, select the parameter, then select Control
from the Parameter source drop-down list. This indicates that the value of the parameter
should be taken from a control. The ControllD drop-down list contains all the controls on
the Web Form. Select the appropriate control for each parameter, then click OK. Now the
Sq1DataSource is configured to insert the user’s name, e-mail address and message in the
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Fig. 25.36 | Setting up INSERT parameters based on control values.

Messages table of the Guestbook darabase. We show how to set the dare parameter and
initiate the insert operation when the user clicks Submit shortly.

ASPX File for a Web Form That Interacts with a Database

The ASPX file generated by the guestbook GUI (and messagesSqiDataSource control) is
shown in Fig. 25.37. This file conuains a large amount of generated markup. We discuss
only those parts that are new or noteworthy for the current example. Lines 1958 contain
the XHTML and ASP.NET elements that comprise the form that gathers user input. The
Gridview control appears in lines 60-85. The <asp:Gridviews start tag (lines 60-63)
contains properties that set various aspects of the Gridview's appearance and behavior,
such as whether grid lines should be displayed between rows and columns. The
DataSourceID property identifies the data source that is used to fill the Gridview with data
at runtime.

Lines 6675 define the Columns that appear in the Gridview. Each column is repre-
sented as a BoundField, because the values in the columns are bound to values retrieved
from the dara source {i.e., the Messages table of the Guestbook database). The DataField
property of each BoundField identifies the column in the data source to which the column
in the Gridview is bound. The HeaderText property indicates the text that appears as the
column header. By default, this is the name of the column in the data source, but you can
change this property as desired. Lines 76-84 contain nested elements that define the styles
used to format the Gridview’s rows. The IDE configured these styles based on your selec-
tion of the Simple style in the Auto Format dialog for the Gridview.

The messagesSqlDataSource is defined by the markup in lines 86-115 in Fig. 25.37.
Line 87 contains a ConnectionString property, which indicates the connection through
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which the Sq1DataSource control interacts with the database. The value of this property
uses an ASP.NET expression, delimited by <%$ and %>, to access the Guestbook-
ConnectionString stored in the ConnectionStrings section of the application’s
web. config configuration file. Recall that we created this connection string earlier in this
section using the Configure Data Source wizard.Lines 88-95 define the DeleteCommand,
InsertCommand, SelectCommand and UpdateCommand propertics, which contain the
DELETE, INSERT, SELECT and UPDATE SQL statements, respectively. These were generated
by the Configure Data Source wizard. In this example, we usc only the InsertCommand. We
discuss invoking this command shortly.

Fig. 25.37 | ASPX file for the guestbook application. (Part | of 4.)
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Fig. 25.37 | ASPX file for the guestbook application. (Part 2 of 4.)



